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1. ЦЕЛЬ И ЗАДАЧИ ВЫПОЛНЕНИЯ КУРСОВОЙ РАБОТЫ 
Курсовая работа  по дисциплине «Цифровые технологии обработки изобразитель-

ной информаций» является самостоятельной работой студента, цель которой - закрепле-
ние  и углубление знаний по дисциплине, а также, получение практических навыков и 
знаний по созданию, обработке и приведению к стандартизованной форме векторных 
изображений. 

Выполнение курсовой работы - одна из важнейших форм самостоятельных занятий 
студентов, способствующая подготовке к сдаче экзамена и более углубленному изуче-
нию учебной дисциплины.  

Подготовка и написание курсовой работы приучает студента к творческому труду, 
формирует навыки анализа литературы и обобщения материала, практики, помогает 
овладеть элементами исследовательского подхода в работе.  

 
1.1. Цель курсовой работы 
Основная цель написания курсовой работы по дисциплине «Цифровые технологии 

обработки изобразительной информаций» состоит в закреплении и углублении знаний 
студента по дисциплине, что в перспективе позволит успешно применять их на практике. 

 
1.2. Задачи курсовой работы 
В результате выполнения курсовой работы студент должен закрепить и расширить 

знания по следующим тематикам: 
- методы создания векторных иллюстраций; 
- логические операции с контурами; 
- заливка по методу градиентных сеток и заливка по методу целлшейдинга; 
- работа со слоями; 
- создание стоковых векторных изображений. 

 
2. ОСНОВНЫЕ ТРЕБОВАНИЯ К КОНТРОЛЬНО-КУРСОВОЙ РАБОТЕ 
2.1.Тематика курсовой  работы 
Курсовая работа посвящена созданию стоковой векторной иллюстрации. 
 
2.2. Исходные данные к курсовой работе 
К методическим указаниям прилагается комплект растровых цифровых изображе-

ний. Студент должен выполнить в векторе отрисовку изображения, соответствующей 
своему номеру варианта. Также допускается выбор студентом изображения для отрисов-
ки самостоятельно, по согласованию с руководителем курсовой работы. 

 
2.3. Структура курсовой работы 
Курсовая работа должна включать следующие разделы: 
- расчетно-пояснительную записку; 
- комплект промежуточных цифровых изображений и сопутствующих элементов в 

электронном виде на любом оптическом дисковом носителе. 
В электронном виде сдаются: 
1) Стоковое изображение полученное в результате выполнения курсовой работы. 
2)Минимум 6 промежуточных фаз, сопровождающих создание каждого изображе-

ния. 
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3) Наборы образцов цвета, градиентов, узоров, стилей, кистей и т.д. созданные и 
использованные в процессе создания изображений. 

Пояснительная записка к курсовой работе должна включать следующие разделы: 
1) Титульный лист (приложение  1). 
2) Оглавление. 
3) Материал курсовой работы согласно выданному заданию (пошаговая обработка 
изображений с численными величинами всех параметров и принтскринами каждо-
го шага)   
4) Выводы по курсовой работе. 
5) Список использованной литературы (не менее 3-х наименований). 
 
Примерное  распределение  материала расчетно-пояснительной записки по разде-

лам в процентах от полного объема приведено в таблице 1.  
Таблица 1. 

Разделы контрольно-курсовой  работы Примерный объем 
Введение 10 % 
Выявление характерных признаков объектов 
иллюстрации.  

15% 

Создание базовых контуров объектов. 15% 
Заливка и покраска изображения базовыми цве-
тами 

15% 

Покраска изображения 15% 
Доводка изображений 15% 
Выводы 5% 

 
2.4. Объем курсовой работы 
Законченная курсовая работа  оформляется  в  виде  отчета, включающего: 
- расчетно-пояснительную записку объемом 20 - 40 страниц текста на листах фор-

мата А4; 
- комплект промежуточных цифровых изображений и сопутствующих элементов в 

электронном виде на любом оптическом дисковом носителе. 
 
2.3. Рекомендации по выполнению курсовой работы 
Выполняя курсовую работу, необходимо внимательно ознакомиться с тематикой 

работы и написать развернутый и аргументированный отчет. При написании работы 
необходимо проанализировать научную и учебную специальную литературу, публика-
ции в периодической печати. 

 
3. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ РАЗДЕЛОВ 

КУРСОВОЙ РАБОТЫ 
3.1. Основные инструменты создания контуров. 
Кривые Безье строятся по нескольким точкам и направляющим линиям. Точки, по 

которым строится кривая, называются опорными (или узловыми) точками; каждая из них 
характеризуется двумя отрезками, расположенными на касательной к кривой Безье в 
опорной точке (они называются направляющими). Длина каждой из них задает крутизну 
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следующего или предыдущего сегмента кривой, а угол касательной задает направление в 
обе стороны от опорной точки. 

Для создания и редактирования кривых Безье служит следующая группа инстру-
ментов. 

 
Рисунок 1. Инструменты создания и редактирования кривых Безье. 

 
Pen Tool (Перо) позволяет создавать новый контур, состоящий из кривых Безье. 

При щелчках мышью создает новые опорные точки. Если щелкнуть мышью и после со-
здания точки не отпускать кнопку, то движение мыши деформирует предыдущий сег-
мент контура и направляющую для последующего. 

 
Рисунок 2. У первого контура опорная точка создана только щелчком, а у второго про-

тяжкой. 
 
При попадании на уже существующую опорную точку, Pen Tool (Перо) работает 

как Delete Anchor Point Tool (Удаление Опорной Точки). При попадании на уже суще-
ствующий сегмент контура  Pen Tool (Перо) работает как Add Anchor Point Tool (Добав-
ление Опорной Точки). 

Add Anchor Point Tool (Добавление Опорной Точки) создает новую опорную точку 
на уже существующем контуре. Если эта часть контура прямолинейная, то точка создает-
ся без направляющих. Если часть контура изогнута, то точка создается с направляющими 
таким образом, что форма контура не изменяется. При попадании инструментом в место, 
где контуры отсутствуют, появляется окно предупреждения. Это и многие другие преду-
преждения  можно отключить, запретив показывать окно в дальнейшем. 

 
Рисунок 3. Добавление опорной точки. Форма контура не меняется. 
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Delete Anchor Point Tool (Удаление Опорной Точки) удаляет существующую опор-
ную точку. При этом точка удаляется вместе с направляющими и форма контура изменя-
ется. 

 
Рисунок 4. Удаление опорной точки. Форма контура изменяется. 

 
 
Convert Anchor Point Tool (Преобразование Опорной Точки) позволяет деформиро-

вать контур  и создать для опорной точки направляющие. При первом преобразовании 
направляющие будут расположены под углом 180 градусов, и величина деформации в 
обе стороны будут одинакова. Если требуется различная деформация и угол направляю-
щих, следует произвести второе преобразование. 

 
Рисунок 5. Исходный контур, первое преобразование опорной точки, второе преобразо-

вание опорной точки. 
 
Еще один инструмент который непосредственно участвует в работе с контурами – 

это Direct Selection Tool (Прямое Выделение). Он позволяет деформировать контуры, из-
меняя направляющие и перемещать опорные точки. Следует учесть, что если направля-
ющие были до этого деформированы только один раз, то Direct Selection Tool (Прямое 
Выделение) будет изменять величину деформации, но угол между направляющими так и 
останется равным 180 градусам. Чтобы удалить опорную точку или сегмент, не затронув 
остальные элементы, следует выделить точку или сегмент с помощью Direct Selection 
Tool (Прямое Выделение) и нажать клавишу Delete. Чтобы объединить два отдельных 
контура, следует  выделив их крайние опорные точки инструментом Direct Selection Tool 
(Прямое Выделение) и вызвав правой кнопкой мыши контекстное меню, выбрать коман-
ду Join (Объединить). Точки будут соединены сегментом. 

Для того, чтобы выделять, перемещать, трансформировать контур в целом ( и сег-
менты и опорные точки) служит инструмент Selection Tool (Выделение). Чтобы выделить 
несколько контуров следует либо очертить нужные контуры инструментом, либо зажать 
в процессе выделения клавишу Shift и поочередно щелкнуть на контуры. 

Под графическими примитивами понимаются минимальные графические объекты, 
которые составляют векторный рисунок: линии, прямоугольники, окружности, эллипсы, 
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дуги, сегменты, секторы, кривые Безье. Графические примитивы могут составлять более 
сложные объекты благодаря функции комбинирования и логическим операциям над кон-
турами. 

Для создания графических примитивов в виде геометрических фигур служит спе-
циальная группа инструментов. 

 
Инструмент Rectangle Tool (Прямоугольник) позволяет создавать прямоугольные 

контуры путем протягивания мыши с зажатой левой кнопкой по полю документа. Если 
при этом удерживать клавишу Shift, то получится квадрат. При одиночном щелчке по по-
лю документа появляется диалоговое окно, которое позволяет задать жесткие параметры 
прямоугольника – ширину и высоту в любых доступных единицах измерения. 

Инструмент Rounded Rectangle Tool (Прямоугольник со Скругленными Углами) поз-
воляет создавать контуры в виде прямоугольника со скругленными углами путем протя-
гивания мыши с зажатой левой кнопкой по полю документа. Если при этом удерживать 
клавишу Shift, то получится квадрат со скругленными углами. При одиночном щелчке по 
полю документа появляется диалоговое окно, которое позволяет задать жесткие парамет-
ры прямоугольника – ширину, высоту и радиус скругления углов в любых доступных 
единицах измерения. 

Инструмент Ellipse Tool (Эллипс) позволяет создавать эллиптические контуры пу-
тем протягивания мыши с зажатой левой кнопкой по полю документа. Если при этом 
удерживать клавишу Shift, то получится окружность. При одиночном щелчке по полю 
документа появляется диалоговое окно, которое позволяет задать жесткие параметры эл-
липса - ширину и высоту в любых доступных единицах измерения. 

Инструмент Polygon  Tool (Многоугольник) позволяет создавать правильные вы-
пуклые многоугольники путем протягивания мыши с зажатой левой кнопкой по полю 
документа. При одиночном щелчке по полю документа появляется диалоговое окно, ко-
торое позволяет задать жесткие параметры многоугольника – радиус описанной окруж-
ности и число сторон в любых доступных единицах измерения. 

Инструмент Star Tool (Звезда) позволяет создавать правильные выпуклые невыпук-
лые многоугольники путем протягивания мыши с зажатой левой кнопкой по полю доку-
мента. При одиночном щелчке по полю документа появляется диалоговое окно, которое 
позволяет задать жесткие параметры многоугольника – радиус описанной окружности, 
радиус вписанной окружности и число углов в любых доступных единицах измерения. 

Инструмент Flare Tool (Линза) используется крайне редко в силу того, что создает 
весьма специфический эффект. 

Еще одна группа инструментов предназначена для создания разного рода линей-
ных графических примитивов. 

Инструмент Line Segment Tool (Линейный Сегмент) позволяет создавать контур в 
виде сегмента прямой линии, ограниченного на концах опорными точками. Щелчок по 
полю документа позволяет задать длину линии и угол наклона. 

Инструмент Arc Tool (Дуга) позволяет создавать контур в виде сегмента изогнутой 
линии, ограниченного на концах опорными точками. Щелчок по полю документа позво-
ляет задать тип, длину осей, выгнутость дуги. 

Инструмент Spiral Tool (Спираль) создает спиральную линию. Щелчок по полю до-
кумента позволяет задать радиус, тип и число сегментов спирали. 
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Инструмент Rectangular Grid Tool (Прямоугольная сетка) создает сетку прямо-
угольных координат. Щелчок по полю документа позволяет задать ширину, высоту и 
число ячеек. 

Инструмент Polar Grid Tool (Сетка Полярных Координат) создает сетку радиаль-
ных  координат. Щелчок по полю документа позволяет задать ширину, высоту и число 
ячеек. 

Paint Brush Tool (Кисть) позволяет создавать контур произвольной формы. По 
умолчанию он обладает свойствами обводки. Полученный контур может редактировать-
ся инструментами, описанными выше. 

Инструмент Pencil Tool (Карандаш) позволяет создавать произвольный контур с 
заданными стилевыми настройками. 

Инструмент Smooth  Tool  (Сглаживание) позволяет уменьшить перегиб в узловых 
точках для контура, созданного с помощью Pencil Tool (Карандаш). 

Инструмент Eraser Tool  (Ластик) позволяет удалять фрагменты контура, создан-
ного с помощью Pencil Tool (Карандаш). 

3.2. Трансформация и выравнивание. 
В программе Adobe Illustrator при выделении объекта вокруг него появляется рам-

ка. При подведении курсора к ее угловым или средним точкам, он меняет свой вид на 
двойную стрелку. Это означает, что в данный момент можно изменять размеры объекта 
мышкой. Если при этом зажать клавишу Shift, масштабирование будет пропорциональ-
ным. При выведении курсора чуть далее за рамку, он меняет свой вид на изогнутую 
двойную стрелку. Это означает, что в данный момент доступен поворот объекта. 

Функции свободного трансформирования объектов также выполняет палитра 
Transform (Трансформация). В целом она позволяет достаточно точно трансформировать 
объекты. Привязка координат идет к нижнему левому углу документа. 

 
Рисунок 6. Палитра Transform (Трансформация). 

 
В контекстном меню палитры представленные следующие команды: 
Flip Horizontal (Отразить Горизонтально) – отразить объект относительно верти-

кальной оси. 
Flip Vertical (Отразить Вертикально)  - отразить объект относительно горизон-

тальной оси. 
Scale Stroke & Effects (Растягивать Обводку и Эффекты) – опция, позволяющая 

применять трансформации не только к форме самого объекта, но и к обводке и заливке. 
Transform Objects Only (Трансформировать Только Объекты) - опция, позволяю-

щая применять трансформации только к форме контуров. 
Transform Pattern Only (Трансформировать Только Узоры) - опция, позволяющая 

применять трансформации только к узорной заливке выбранного объекта. 
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Transform Both (Трансформировать Оба) - опция, позволяющая применять транс-
формации и к форме, и к узорной заливке выбранного объекта. 

Ряд вышеперечисленных функций дублируется отдельными инструментами. 
Инструмент Free Transform Tool (Свободная Трансформация) позволяет масштаби-

ровать и поворачивать объекты. 
Инструмент Rotate Tool (Поворот) позволяет поворачивать объекты, установив 

точку привязки произвольно. 
Инструмент Reflect Tool (Отражение) позволяет отражать объекты относительно 

произвольной оси. 
Инструмент Scale Tool (Растяжение) позволяет масштабировать объекты, выбрав 

произвольную точку привязки. 
Инструмент Shear Tool (Искажение) позволяет искажать объекты, масштабируя их 

непропорционально. 
Также вышеперечисленные функции дублируются командами раздела меню Object 

> Transform (Объект > Трансформация). 
Для управления выравниванием  и распределением объектов служит палитра Align 

(Выравнивание). 

 
Рисунок 7. Палитра Align (Выравнивание). 

 
3.3. Стилевые свойства. 
В векторной графике как нигде более актуально понятие стиля. В понятие стиля 

входят все свойства объекта, не относящиеся к его форме. В самом примитивном вариан-
те это обводка и заливка. Простейшие инструменты управления заливкой и обводкой вы-
несены в низ палитры инструментов. та область позволяет переключаться между управ-
лением цветами обводки и заливки, выбирать их тип, или отключать заливку и обводку, а 
так же восстанавливать умолчальные параметры – заливка белым, обводка черным. 

 
Рисунок 8. Нижняя часть палитры инструментов. 
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Для управления всеми остальными параметрами обводки кроме цвета, служит па-
литра Stroke (Обводка). Эта и ряд других палитр может быть развернута в разной степе-
ни. Для разворачивания большего числа опций следует несколько раз дважды кликнуть 
на названии палитры. 

 
Рисунок 9. Палитра Stroke (Обводка). 

 
Палитра Swatches (Образцы) в целом функционирует похожим на Adobe Photoshop 

образом с той лишь разницей, что здесь помимо цветов на палитру вынесены узоры и 
градиенты. 

 
Рисунок 10. Палитра Swatches (Образцы). 

 
Следует помнить, что к обводке может быть применен только цвет. 
Для изменения текущего цвета предназначена палитра Color (Цвет). Она функцио-

нирует точно так же, как одноименная палитра Adobe Photoshop. Для управления 
настройками текущего градиента служит палитра Gradient (Градиент).  
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Рисунок 11. Палитра Gradient (Градиент). 

 
Данная палитра обладает более узкими по сравнению с Adobe Photoshop возможно-

стями. Доступно всего два вида градиента, для линейного градиента можно задавать угол 
поворота. Для ключевых точек можно задавать только цвет но не прозрачность. Чтобы 
задать ключевой точке цвет следует либо выбрать ее и откорректировать цвет на палитре 
Color (Цвет), либо перетащить на нее образец цвета с палитры Swatches (Образцы). 

Все созданные цвета и градиенты можно сохранять в текущем наборе на палитре 
Swatches (Образцы).  

Для того, чтобы присвоить какой-либо цвет, узор или градиент контуру, следует, 
выбрав на панели инструментов обводку или заливку, щелкнуть на соответствующем об-
разце палитры Swatches (Образцы). Точно так же как и в Adobe Photoshop с помощью 
этой палитры можно загружать уже существующие наборы образцов. 

Еще один важный элемент стиля – это прозрачность. Для ее регулирования предна-
значена палитра Transparency (Прозрачность). Большинство настроек этой палитры для 
продвинутых пользователей. По факту, в большинстве случаев, используются лишь пол-
зунок и поле Opacity (Непрозрачность). 

 

 
Рисунок 12. Непрозрачность зеленого прямоугольника 100% и 50%. 

 
Весьма полезной для управления стилевыми свойствами объектов является палитра 

Appearance (Оформление). При выборе какого-либо объекта на этой палитре появляется 
полный перечень его стилевых свойств. Каждое из них можно продублировать или уда-
лить с помощью соответствующих пиктограмм. Эта палитра тем более полезна, что зача-
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стую по внешнему виду объектов невозможно определить их реальные стилевые свой-
ства. 

В тех случаях, когда несколько объектов используют одинаковый стиль, целесооб-
разно сохранить этот стиль с помощью палитры Graphic Styles (Графические Стили). Она 
действует аналогично палитре Swatches (Образцы). Достаточно выделить объект нужно-
го стиля и щелкнуть по пиктограмме New Graphic Style (Новый Графический Стиль). 

В заключение темы о графических стилях следует упомянуть еще одну возмож-
ность – использование кистей. По умолчанию, только инструмент Brush (Кисть) исполь-
зует кистевую обводку. Обычные контуры если и используют обводку, то это просто ли-
ния определенной толщины. Тем не менее к уже существующему контуру тоже можно 
применить обводку кистью. 

В палитре  Brushes  (Кисти), которая вызывается на экран командой  Brushes  (Ки-
сти) меню  Window  (Окно), можно выбрать четыре типа кистей:  

-   кисть  Calligraphic  (Каллиграфическая) создает штрихи, напоминающие письмо 
широким пером, расположенным под определенным углом к линии письма;  

 -  кисть  Scatter  (Диффузорная) "разбрасывает" ("распыляет") копии объектов 
вдоль траектории;  

 -  кисть  Art  (Изобразительная) создает штрих методом растягивания вдоль траек-
тории какого-либо изображения, например рисунка сложной стрелки;  

 -  кисть  Pattern  (Декоративная), которая располагает вдоль траектории серию от-
дельных декоративных элементов (tile), число образцов которых может доходить до 4, 
например отдельный образец для стороны, внутреннего угла, внешнего угла и краев кон-
тура.  

 Палитра  Brushes  (Кисти) очень напоминает соответствующую палитру програм-
мы Adobe Photoshop, она также позволяет использовать готовые кисти, создавать новые 
или загружать из библиотеки. Для того, чтобы применить кисть к контуру следует при 
выбранном контуре щелкнуть по соответствующей кисти в палитре Brushes  (Кисти). 

Загрузить один или несколько наборов кистей можно с помощью команды  Brush 
Libraries  (Библиотеки кистей) меню  Window  (Окно), которая открывает список биб-
лиотек кистей, хранящихся в указанной папке. Вариант  Other Library  (Другая Библио-
тека) позволяет загрузить документ с образцами кистей из любой другой папки (если 
они там есть).  

 После выбора одной из библиотек набор кистей отображается в специальной па-
литре без имени (имя библиотеки указывается на вкладке), работав которой ограничива-
ется присвоением кисти выделенному контуру и возможностью перенести кисть в палит-
ру  Brushes  (Кисти) методом "перетаскивания" или с помощью команды  Add to Brushes  
(Добавить в Палитру) меню палитры. В самой палитре библиотек кистей добавлять, 
удалять или изменять параметры кистей нельзя.  

В меню палитры расположена также команда  Brush Options  (Параметры Кисти), 
предназначенная для изменения всех параметров конкретной кисти. Если требуется из-
менить достаточно быстро некоторые параметры кисти, то этого можно добиться перене-
сением рисунка из палитры  Brushes  (Кисти) на рабочий стол. После соответствующей 
обработки видоизмененный образец кисти возвращается обратно в палитру.  

 Для этого необходимо выделить в палитре  Brushes  (Кисти) нужную кисть, пере-
местить ее на свободное пространство рабочего стола, выполнить преобразование, 
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например масштабирование или более существенное изменение рисунка (рисунок кисти 
— это обычный векторный объект), а затем снова перенести его в палитру.  

 При этом на экран выводится диалоговое окно  New Brush  (Новая Кисть), в кото-
ром необходимо указать тип помещаемой кисти.  

3.4. Слои. 
Палитра Layers (Слои) в Adobe Illustrator выглядит и функционирует похожим на 

Adobe Photoshop способом. 

 
Рисунок 13. Палитра Layers (Слои). 

 
У каждого слоя точно так же может включаться и выключаться видимость, а рядом 

с пиктограммой видимости находится чекбокс блокировки. Заблокировать слой можно 
только полностью – для перемещения, изменения цвета и стиля находящихся в нем объ-
ектов. 

 В Adobe Illustrator нет понятия групп слоев, однако слои могут быть вложенными. 
Для этого даже существует две пиктограммы на палитре. Пиктограмма Create New Sub-
layer (Создать Новый Вложенный Слой) создает новый слой внутри текущего.   Пикто-
грамма Create New Layer  (Создать Новый Слой) создает новый слой поверх текущего. 

Двойной щелчок на имени слоя вызывает диалоговое окно Layer Options (Пара-
метры Слоя). 

 
Рисунок 14. Диалоговое окно Layer Options (Параметры Слоя). 

 
Функция выбора цвета очень полезна, так как по умолчанию, цвет активных эле-

ментов каждого слоя выбирается программой в определенном порядке. Тем не менее, ес-
ли производятся действия с объектами с черной обводкой, а цвет слоя тоже черный, то 
кривых Безье и направляющих практические не видно. В таком случае целесообразно 
сменить цвет слоя на контрастный, например на голубой или розовый. 
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Непосредственно в строке с названием слоя  находятся еще две важных пикто-
граммы. Пиктограмма в виде треугольной  стрелки «раскладывает» слой, наглядно отоб-
ражая все его содержимое. Чекбокс  в виде круга, будучи активизированным, выделяет 
все видимые элементы активного слоя. 

 
Рисунок 15.  Разложение слоя и выделение его содержимого. 

 
При разложении слоя становится видно, что каждый объект, по сути, представляет 

собой автономный слой и даже в пределах слоя объекты следуют в определенном поряд-
ке. Каждый из них точно так же можно выделить для редактирования и перемещения по 
полю документа не только с помощью инструмента Selection Tool (Выделение) но и с по-
мощью чекбокса на палитре Layers (Слои). 

Чтобы выделить слой или объект для переупорядочивания, копирования, удаления, 
достаточно щелкнуть мышью на его превью или имя и перетянуть на нужное место или 
пиктограмму. Если перетянуть слой или объект на пиктограмму создания нового слоя, 
создастся его копия. Это очень удобная функция, так как при использовании буфера об-
мена вставка объекта производится по центру области просмотра, а не в том месте, где 
этот объект находился. 

Возвращаясь к тому, что каждый объект по сути, представляет собой автономный 
слой, следует заметить, что управлять их порядком можно не только с помощью палитры  
Layers (Слои), но и с помощью контекстного меню, вызываемого при выделенном объек-
те правой кнопкой мыши. 
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В подразделе Arrange (Упорядочить) есть следующие функциональные возможно-
сти: 

Bring to Front (Поместить на Передний План) – делает объект самым верхним в 
пределах текущего слоя. 

Bring Forward (Переместить Вперед) – перемещает объект на одну позицию вверх. 
Send Backward (Переместить Назад) – перемещает объект на одну позицию вниз. 
Send to Back (Поместить на Задний План) – делает объект самым нижним в преде-

лах текущего слоя. 
Если часть изображения уже нарисована, и необходимо зафиксировать положение 

объектов относительно друг друга, применяется команда контекстного меню Group 
(Группировать). При этом объекты объединятся в группу. Это будет наглядно отображе-
но на палитре Layers (Слои). Для того, чтобы разгруппировать объекты следует восполь-
зоваться командой контекстного меню Ungroup (Разгруппировать), либо, разложив 
группу на палитре Layers (Слои), выделить ее содержимое и перетащить за пределы 
группы. Таким же образом можно выносить и вносить в группу отдельные объекты. 

3.5. Взаимодействие контуров. 
Палитра  Pathfinder  (Обработка Контуров) предназначена для комбинирования 

объектов различными способами, зачастую с образованием составных контуров 
(Compound path). Следует учесть, что при комбинировании незамкнутые контуры стано-
вятся замкнутыми. 

 Палитра  Pathfinder  (Обработка Контуров) является очень мощным средством 
векторного формообразования, что чрезвычайно ценно для создания довольно сложных 
форм. В связи с этим можно временно не обращать внимания на параметры заливок и об-
водок., а присваивать нужные стилевые свойства уже после достижения нужной формы. 

 
Рисунок 16. Палитра Pathfinder  (Обработка Контуров). 

 
Контекстное меню палитры Pathfinder  (Обработка Контуров) позволяет выбрать 

ее настройки с помощью команды Pathfinder  Options (Параметры Обработки Конту-
ров). Она вызывает одноименное диалоговое окно. 

В поле  Precision  (Точность вычислений) вводится степень точности, с которой ко-
манды палитры  Pathfinder  (Обработка Контуров) выполняет вычисления при комбини-
ровании выделенных объектов. Чем меньшее значение установлено, тем с большей точ-
ностью выполняются вычисления, и тем больше машинного времени требуется соверше-
ния операции.  При установке флажка  Remove Redundant Points  (Удалять Лишние Точ-
ки) обеспечивается удаление любых опорных точек, которые расположены  друг над дру-
гом в пределах заданной точности и при комбинировании являются излишними.  

  При установке флажка  Divide and Outline Will Remove Unpainted Artwork  (Уда-
лять незакрашенные объекты) удаляются все незаполненные объекты, получаемые в ре-
зультате выполнения команд  Divide  (Разделение) и  Outline  (Обводка). 
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Для комбинирования объектов следует разместить и выделить необходимые объек-
ты, а затем нажать одну из кнопок палитры  Pathfinder  (Обработка Контуров). Объекты, 
входящие в составные объекты, не изменяются и располагают почти полной свободой 
распоряжения ими, например остается возможность изменять форму, расположение в 
вертикальной стопке и местоположение. Открытые контуры, попадающие в состав со-
ставного объекта, автоматически замыкаются. Сложный контур (compound path) состоит 
из двух или более простых контуров. При комбинировании контуров с различными цвет-
ными заливками, как правило, результирующему объекту присваивается заливка верхне-
го объекта (об исключениях сообщается особо). 

Рассмотрим подробно все пиктограммы палитры Pathfinder  (Обработка Конту-
ров). Если требуется создать составной контур, и удалить незначащие части, следует 
нажать кнопку  Expand  (Преобразовать).  

Кнопка  Add to shape area  (Добавление в составной объект) на панели комбиниру-
ет выделенные объекты таким образом, что контур результирующего объекта совпадает с 
общим периметром всех объектов. Если комбинируемые объекты не имеют пересечений, 
они все равно объединяются в единый объект с одинаковыми параметрами контура и за-
ливки. 

 
Рисунок 17. Исходные объекты, объекты в режиме добавления, окончательный контур. 

 
Кнопка  Subtract from shape area  (Удаление из составного объекта) комбинирует 

выделенные объекты таким образом, что контур результирующего объекта равняется 
площади самого нижнего объекта с вырезом площадей объектов, расположенных над 
ним.  

 
Рисунок 18. Исходные объекты, объекты в режиме вычитания, окончательный контур. 

 
Кнопка  Intersect shape areas  (Пересечение составных объектов) на панели комби-

нирует выделенные объекты таким образом, что контуром результирующего объекта яв-
ляется область пересечения объектов.  
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Рисунок 19. Исходные объекты, объекты в режиме пересечения, окончательный контур. 

 
Кнопка  Exclude overlapping shape areas  (Исключение пересекающихся областей) 

комбинирует выделенные объекты таким образом, что непересекающиеся области входят 
в результирующий объект, а пересекающиеся — "исключаются", делаются прозрачными.  
Однако при этом следует учитывать количество пересекаемых областей:     если их число 
четное, то они становятся прозрачными;    если их число нечетное, они включаются в 
объект с соответствующей заливкой.  

Кнопка  Divide  (Разделение) на панели выполняет в некотором смысле противопо-
ложное действие в сравнении с комбинированием: она разбивает сложный объект на 
простые объекты. Пользователь должен заранее решить, удалять или сохранять объекты 
без заливки. Следует обратить внимание, что команда Divide (Разделение) не возвращает 
исходные объекты, существующие до выполнения, например, команды Exclude (Исклю-
чение), а разбивает сложный объект на объекты, представляющие собой отдельные за-
полненные области.  После применения кнопки  Divide  (Разделение) все образуемые 
объекты остаются в группе, для свободного манипулирования отдельными объектами 
следует выполнить команду  Ungroup  (Разгруппировать) меню  Object  (Объект) или 
контекстного меню.  

Кнопка  Trim  (Обрезка) комбинирует выделенные объекты таким образом, что 
удаляет все части объектов, которые являются скрытыми, при этом объекты с одинако-
выми заливками не объединяются.  Следует иметь в виду, что при этом удаляются пара-
метры обводки.   После применения кнопки  Trim  (Обрезка) все образуемые объекты 
остаются в группе. 

Кнопка  Merge  (Слияние) комбинирует выделенные объекты таким образом, что 
удаляет все части объектов, которые являются скрытыми, при этом объекты с одинако-
выми заливками объединяются. Следует иметь в виду, что при этом удаляются парамет-
ры обводки. После применения кнопки  Merge  (Слияние) все образуемые объекты оста-
ются в группе. 

Кнопка  Crop  (Кадрирование) комбинирует выделенные объекты таким образом, 
что удаляет все части объектов, которые выходят за границы самого верхнего объекта. 
Верхний объект после применения кнопки удаляется, а все образуемые объекты остаются 
в группе.  

Кнопка  Outline  (Обводка) аналогична команде  Divide  (Разделение), только разби-
ение происходит не на закрытые объекты, а на открытые контуры — отдельные линии, 
разбиваемые в точках пересечения. После применения кнопки  Outline  (Обводка) все об-
разуемые контуры остаются в группе. 

 
Кнопка  Minus Back  (Минус нижний) комбинирует выделенные объекты таким об-

разом, что результирующим объектом становится самый верхний объект, у которого от-
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секается область, пересекающаяся со всеми объектами, расположенными ниже. Данная 
кнопка также сохраняет исходную заливку объекта. 

3.6. Понятие стоковой графики. 
Стоковая графика – это изображения, предназначенные для покупки/продажи в вы-

соком качестве на специальных сайтах. Для того, чтобы изображение прошло процедуру 
добавления в каталог, оно должно соответствовать ряду требований. Если в случае с фо-
тографиями большинство требований относятся к их художественной ценности и легаль-
ности использования моделей, то в случае с векторной графикой речь идет о ряде весьма 
жестких технических требований. Все ограничения вызваны возможной несовместимо-
стью форматов и программ и направлены на то, чтобы изображение корректно открыва-
лось любым приложением для обработки векторной графики. Приведем эти требования и 
рекомендации по их достижению вкратце, но сначала дадим определение понятию «раз-
борка».  Разборка – это процесс преобразования сложных элементов в графические при-
митивы. Для того, чтобы выполнить разборку следует воспользоваться командой меню 
Object > Expand (Объект > Разобрать)  или Object > Expand Appearance (Объект > 
Разобрать Оформление) со следующими параметрами. 

 
Рисунок 20. Параметры разборки. 

 
1)  Стоковый вектор не должен содержать мусора: одиночных точек (Stray Points) и 

невидимых линий. Для выделения одиночных точек следует воспользоваться командой 
меню Select > Object > Stray Points (Выбрать > Объекты > Пустые Точки). Для выделе-
ния невидимых (без заливки и обводки) линий, нужно нарисовать такую линию, выде-
лить ее и воспользоваться командой меню Select > Same > Fill & Stroke   (Выбрать > 
Одинаковые  > Заливка и Обводка). После выделения мусор следует удалить. 

2) Стоковый вектор не должен содержать обводок (обычных или с помощью спе-
циальных кистей). Любые обводки должны быть разобраны. Для того, чтобы выделить 
все объекты, обведенные кистями, следует воспользоваться командой меню Select > Ob-
ject > Brush Strokes (Выбрать > Объекты > Штрихи Кисти). Для того, чтобы выделить 
все объекты, имеющие обводку определенного цвета , следует выделить один из них и 
воспользоваться командой меню Select > Same > Stroke Color  (Выбрать > Одинаковые  
> Цвет Обводки). После того, как нужные объекты выделены следует выбрать их раз-
борку, разгруппировать, если появились группы и удалить пути без обводки и заливки. 
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Рисунок 21. Контур с обводкой кистью и тот же контур в разобранном виде. 

 
3) Стоковый вектор не должен содержать незамкнутых контуров. Все контуры 

должны быть замкнуты, а если контур играет роль обводки, то он должен быть разобран 
и замкнут. 

 
Рисунок 22. Незамкнутый и замкнутый контуры. 

 
4) Стоковый вектор не должен содержать шрифтов. Все шрифтовые элементы 

должны быть преобразованы в контуры. Для этого следует выделить текст и выполнить 
команду меню Type > Create Outlines (Текст > Преобразовать в Контуры). 

5) Стоковый вектор не должен содержать  прозрачности (Transparency). Чтобы 
определить прозрачность следует выделить инструментом Selection (Выделение) объект, 
и на палитре Transparency (Прозрачность) или Appearance (Оформление) посмотреть 
значение Opacity (Непрозрачность). Непрозрачный объект Opacity - 100%.  

6) Стоковый вектор не должен содержать градиентных сеток. По выполнению это-
го и предыдущего пунктов нельзя дать однозначных рекомендаций – единственный вы-
ход – это продумывать исполнение иллюстрации таким образом, чтобы  эффекты не бы-
ло необходимости использовать. 

7) Стоковый вектор не должен содержать узоров (Pattern). Все узоры должны быть 
разобраны. Для этого следует их выделить и воспользоваться командой меню Object > 
Expand (Объект > Разобрать). 

8) Стоковый вектор не должен содержать режимы наложения (Multiply, Screen и 
так далее). 

9) Стоковый вектор не должен содержать эффектов и символов. 
Разумеется, это не полный список требований, у каждого микростока они индиви-

дуальны. Однако их выполнение может помочь при подготовке векторных иллюстраций 
для межплатформенного и межпрограммного обмена. 
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3.4. Оформление пояснительной записки 
Титульный лист пояснительной записки оформляется в соответствии с приложени-

ем 1. 
Пояснительная записка оформляется в соответствии с ЕСКД и ГОСТ 2.105-79 (см. 

приложение 3). 
Примечание: Допускается  не  делать рамку на листах пояснительной записки. 
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ПРИЛОЖЕНИЕ 3 
Правила оформления пояснительной записки  

Пояснительная записка пояснительная записка набирается на компьютере в тексто-
вом редакторе типа  Лексикон (под MS DOS) или  WORD (под Windows).  

При использовании WORD, текст набирается шрифтом Times New Roman (Cyr) ве-
личиной 14 пунктов с одинарным интервалом. Формат бумаги - А4. Абзацный отступ - 
1,25 см. Все поля страницы – по 2 см, переплет – 1 см. Текст на странице выравнивается 
по ширине. 

Таблицы желательно располагать на странице без разрыва, а в случае переноса на 
другую страницу – дублируется шапка таблицы. 

Рисунки располагаются по тексту пояснительной записки. В порядке исключения 
рисунки могут быть выполнены на отдельных листах белой бумаги, либо на кальке чер-
ной тушью или пастой. Рисунки имеют подрисуночную надпись и нумерацию – либо 
сквозную, либо по разделам. 

Формулы следует выполнять  в  редакторе Microsoft  Equation со следующими  
размерами:     

обычный ....................................  18 пт; 
крупный индекс ........................  14 пт;   
мелкий индекс ..........................  12 пт; 
крупный символ .......................  24 пт;   
мелкий символ ..........................  10 пт. 
Шрифты:   Times New Roman (Cyr), Symbol. 
Ссылки на литературу даются  в квадратных скобках. 
Желательно проверять орфографию и грамматику текста пояснительной записки 

перед распечаткой – для этого в редакторах имеются специальные опции! 
Второй страницей пояснительной записки (первая – титульный лист) является ан-

нотация. На этом листе необходимо выполнить рамку и основную надпись как для тек-
стовых документов (см. спецификацию).  

Остальные требования к пояснительной записке – см. ГОСТы на выполнение тек-
стовых документов. 

Образец выполнения титульного листа прилагается (приложение 1). В библиотеке 
кафедры  имеется его электронная версия. 
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ВВЕДЕНИЕ 
Стоковая изображение - это изображение на определённую тематику, которое про-

дается на общедоступных торговых площадках (мировом стоковом рынке) и может быть 
использовано в качестве иллюстрации или рекламы. Стоковые изображения могут быть 
разрешены к использованию (лицензированы) для различных целей. Стоковые изобра-
жения могут быть представлены в онлайновых базах данных, что позволяет потребителю 
получать их дистанционно и немедленно при соответствующей форме оплаты. 

К векторным стоковым иллюстрациям предъявляются весьма жесткие технические 
требования: 

1) Нельзя использовать прозрачность.  
2) Нельзя использовать режимы наложения (вместо векторных объектов будут со-

хранены растровые версии (пиксельная решетка) c векторными масками). 
3) Нельзя использовать растровые элементы. 
4) Нельзя использовать эффекты. 
5) Нельзя использовать градиентные сетки. 
6) Кисти и обводки должны быть разобраны, при этом их опорная линия удалена. 
7) Незамкнутые контуры  должны быть закрыты или разобраны. 
8) Работа не должна содержать мусора, одиночных точек и невидимых линий.  
Часть этих моментов поддается корректировке после того, как изображение нари-

совано, а часть должна продумываться на первом  этапе создания изображения. 
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1. ВЫЯВЛЕНИЕ ХАРАКТЕРНЫХ ПРИЗНАКОВ ОБЪЕКТА ИЛЛЮСТРАЦИИ 
Первым шагом выполнения курсовой работы является всесторонний анализ изоб-

ражаемого объекта. Для отрисовки дано следующее изображение. 

 
Рисунок 1. Исходное изображение. 

 
Выявим ряд характерных особенностей, которые позволят передать вид объекта. 
1) Контуры динамической толщины. На концах они сужаются. Контуры, которые 

очерчивают весь объект толще тех, которые очерчивают отдельные его элементы. 
2) Переходы цвета плавные. 
3) Формы бликов очень просты – в их основе как правило лежат эллипсы. 
4) На исходном изображении нет теней. Из-за этого оно выглядит недостаточно 

контрастным. При отрисовке придется добавить тени. 
Затем для упрощения последующей работы скопируем исходное изображение в 

редактор и выполнить подбор цветов с помощью инструмента Eydropper Tool (Пипетка).  
Для дальнейшего использования их следует сохранить на палитре Swatches (Образцы) 
путем последовательного выбора на рисунке и клика на пиктограмме New Swatch (Но-
вый Образец). 
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Рисунок 2. Подбор образцов цвета. 
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2. СОЗДАНИЕ БАЗОВЫХ КОНТУРОВ ОБЪЕКТОВ 
 С помощью палитры Layers (Слои) уменьшим непрозрачность слоя с образцом и 

заблокируем его. Создав новый слой с помощью инструмента Pen Tool (Перо) создадим 
базовые контуры. Для удобства и лучшей видимости будем создавать контуры без залив-
ки с черной обводкой толщиной 0,5 пункта. Для того, чтобы начать создание новго кон-
тура в процессе использования инструмента Pen Tool (Перо) следует зажать клавишу Ctrl 
и кликнуть в любое место. 

 
Рисунок 3. Уменьшение прозрачности слоя. 

 

 
Рисунок 4. Параметры заливки и обводки черновых контуров. 
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Рисунок 5. Черновой контур. 
 
С помощью инструментов Convert Anchor Point Tool (Преобразование Опорной 

Точки) и Direct Selection Tool (Частичное Выделение)  придадим контурам нужную фор-
му. Для того, чтобы изменить форму контура следует преобразовать его опорную точку 
инструментом Convert Anchor Point Tool (Преобразование Опорной Точки). После перво-
го преобразования направляющие будут расположены под углом 180 градусов. Если тре-
буется сохранить этот угол (а в большинстве случаев это необходимо для создания плав-
ных перегибов) то дельнейшее преобразование направляющих следует использовать ин-
струмент Direct Selection Tool (Частичное Выделение). Для перемещения или выделения 
опорных точек так же используется инструмент Direct Selection Tool (Частичное Выделе-
ние). Для большего удобства можно периодически отключать ободку редактируемого 
контура, а после того, как он искажен до нужной формы возвращать ее. 

 
Рисунок 6. Контролировать форму контура проще, если он не имеет обводки. 
 
Если необходимо добавить опорную точку, то следует кликнуть инструментом Add 

Anchor Point Tool (Добавление Опорной Точки) на сегменте контура. Если необходимо 
удалить опорную точку, то следует кликнуть инструментом и Delete Anchor Point Tool 
(Удаление Опорной Точки) на существующей опорной точке. Если необохдимо удалить 
не только опорную точку, но и сегменты к ней прилегающие, или только сегмент конту-
ра, то нужно выделить их инструментом  Selection Tool (Частичное Выделение) и нажать 
клавишу Delete. 

Возможно, в процессе редактирования понадобится отменить произведенные дей-
ствия. В этом поможет палитра History (История) или комбинация клавиш Ctrl+Z, кото-
рая последовательно отменяет предыдущие действия. Комбинация клавиш Shift+Ctrl+Z 
последовательно возвращает действия. 

Помимо этого, в процессе рисования будем менять масштаб отображения с помо-
щью палитры Navigator (Навигатор). 

Для большего удобства, бывает полезным изменять цвет обводки уже откорректи-
рованных контуров с помощью палитры Swatches (Образцы). 
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Рисунок 7. Маркировка цветом сразу показывает, какие контуры откорректированы, а 

какие нет. 
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Рисунок 8. Откорректированные контуры. 
 
Зажав клавишу Shift инструментом Selection Tool (выделение) выделим те линии, 

которые не описывают форму объектов и с помощью поля Weight (Толщина) палитры 
Stroke (Обводка) установим толщину 0,25 пункта. выделив все контуры с помощью той 
же палитры Stroke (Обводка) зададим следующие режимы обработки – для конечных 
опорных точек Round Cap (Скругленный Конец) для промежуточных опорных точек 
Round Join (Скругленное Соединение). 

 
Рисунок 9. Параметры обводки. 

 
Рисунок 10. Законченные контуры. 

 



 10

Далее наступает один из ключевых моментов обработки. Выделим все контуры и с 
помощью команды меню Object > Path > Outline Stroke (Объект > Контур > Обвести 
Штрих) преобразуем все обводки в замкнутые заливки. С помощью команды контекстно-
го меню, вызываемого правой кнопкой мыши Ungroup (Разгруппировать) или с помощью 
палитры Layers (Слои) разгруппируем контуры. 

 
Рисунок 10. Преобразование заливки в обводку. 

 
После этого с помощью тех же инструментов группы Pen Tool (Перо) следует от-

корректировать каждую линию таким образом, чтобы на концах они сужались, а также 
чтобы линии, описывающие общий контур объектов в пространстве были толще чем ли-
нии, очерчивающие отдельные элементы объекта. 

 
Рисунок 11. Коррекция контуров. 
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Рисунок 12. Окончательные контуры. 

 
Этот момент является ключевым. Именно здесь начинается различие  в создании 

стокового и нестокового вектора. 
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3. ЗАЛИВКА И ПОКРАСКА ИЗОБРАЖЕНИЯ БАЗОВЫМИ ЦВЕТАМИ  
Заблокируем слой с контурами на палитре Layers (Слои) и создадим его копию ни-

же. Именно он будет основой для базовых заливок. 
Выделим все контуры и на палитре Pathfinder (Обработка Контуров) применим к 

ним режим Add to shape area  (Добавление в составной объект). Затем командой кон-
текстного меню Release Compound Path (Разобрать Составной Контур) разберем  его и 
разгруппируем с помощью палитры Layers (Слои).  

 
Рисунок 13. Сгруппированные объекты. 

 
Окрасим все элементы в какой-либо контрастный цвет. 
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Рисунок 14. Разбор составного контура. 

 
Последовательно выбирая каждый элемент на палитре Layers (Слои) и используя 

палитру Pathfinder (Обработка Контуров), либо зальем элемент соответствующим цве-
том, либо удалим, если он не оказывает влияния на заливку. При этом упорядочим эле-
менты с помощью раздела Arrange (Упорядочить) контекстного меню. 
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Рисунок 15. Контур большего размера не участвует в образовании базовых цветов. Он 

остался от полной формы объекта. 
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Рисунок 16. Заливка базовыми цветами. 
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4. ПОКРАСКА ИЗОБРАЖЕНИЯ. 
Далее можно приступать к покраске. Выберем один из элементов залитых базовы-

ми цветами и перенесем его в новый слой. Остальные слои заблокируем. Поверх самого 
элемента создадим контуры теней и бликов.  

 
Рисунок 17. Тени. 

 
Выделив каждый из контуров  тени и создав и выделив копию контура базовой за-

ливки, с помощью палитры Pathfinder (Обработка Контуров) применим к ним режим In-
tersect  shape areas  (Пересечение составных объектов). 

 
Рисунок 18. Режим Intersect  shape areas  (Пересечение составных объектов) палитры 

Pathfinder (Обработка Контуров) 
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Рисунок 19. Согласование формы теней и базовой формы заливки. 

 
Алогично поступим со всеми остальными элементами. 
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Рисунок 20. Покраска. 
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5. ДОВОДКА ИЗОБРАЖЕНИЯ 
После того, как покраска закончена, изменим для некоторых элементов заливку 

цветом на градиент с помощью палитры Gradient (Градиент). Угол наклона градиента бу-
дем регулировать там же. 

 
Рисунок 21. Палитра Gradient (Градиент). 

 

 
Рисунок 22. Образцы градиентов. 
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Рисунок 23. Заливка градиентом. 

 
В заключение нарисуем тень и также зальем ее градиентом. 

 
Рисунок 24. Итоговое изображение. 
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Просмотр  изображения в режиме обводки с помощью команды меню View > Outline 
(Вид > Обводка) показывает, что  имеет место полное совпадение контуров, на изобра-

жении отсутствует мусор. 

 
Рисунок 25. Просмотр изображения в режиме обводки. 
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ВЫВОДЫ 
Соблюсти все  требования к стоковым фотографиям достаточно тяжело. Решить 

проблемы с незамкнутыми контурами, обводками и мусором на изображении можно уже 
после обработки иллюстрации средствами графического редактора. Проблемы же с акку-
ратной покраской можно решить путем использования жесткого алгоритма получения 
заливочных контуров из обводочных. Это дает полное совпадение геометрии контуров, 
отсутствие непрокрашенных или перекрывающихся участков. 
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